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For more details see the Multi Warehouse Inventory extension page.

Multi Warehouse Inventory

Split inventory among multiple warehouses and keep track of stock items on a website or a store view
level. Manage stock data for each separate warehouse on one handy grid.

e Distribute inventory among different warehouses

¢ Assign warehouses to store views and customer groups
e Use a smart algorithm for warehouse selection

e Set a default warehouse for unassigned items

e Separate orders from different warehouses

Stock Settings

To configure general and stock settings please go to Stores —» Configuration - Multi Warehouse
Inventory.

Stock Settings

Multiple Stock Locations |Enable v
~ Please enable to manage the product stock per (7]
warehouse, If disabled, the product stock is
managad natively

Calculate the shipping cost | Y&s -
based on warehouse location

If the option is enabled, the address of a (7]
warehouse is considered as a pick-up address

for the shipping service provider, Shipping rate

to be calculated accordingly.

Separate Orders for Products | Yes v
from different WH

If ‘Mo, one order can be placed with the
products from different Warehouses

Multiple Stock Locations - Set the option to Yes to enable the extension.

Calculate the Shipping cost based on warehouse location - Set the option to Yes to make the
warehouse address a primary pickup address for the shipping service provider. With the option
disabled, the store address, that is mentioned in the config, remains a primary pickup address.

Amasty


https://amasty.com/multi-warehouse-inventory-for-magento-2.html
https://amasty.com/docs/lib/exe/fetch.php?media=magento_2:multi-warehouse-inventory:multi-warehouse-inventory-stock-settings.png
https://amasty.com

2017/11/27 11:49 3/39 Multi Warehouse Inventory

When the ordered products are assigned to multiple warehouses: either multiple orders may be
created, or one order with the shipping rates calculated separately for each warehouse and
summarized.

Separate Orders from Different Warehouses - in case one order contains products from different
warehouses, the module will divide them into several shipments and calculate delivery costs for each
shipment separately depending on the warehouse location.

Decrease Available Stock When | Yes =
Order is Placed . .
ionon  Decrease Stock Quantity available for sale if (7]

order is placed

Decrease Physical Stock during | Order Shipment v

Decrease Physical Stock Quantity (7]

Decrease Available Stock When Order is placed - If the option is set to 'yes', the available stock
will be automatically decreased once an order is placed (Available Qty = Physical Stock - Qty to ship).
If the option is disabled 'Available Quantity' will be equal to 'Physical Quantity'(Physical Qty =
Available Qty + Qty to Ship).

Available Qty = Physical Qty (are identical) when 'Decrease Available Qty When Order is placed'is set
to 'No'.

Decrease physical stock during- Choose the condition to decrease Physical Quantity (Physical Qty
= Available Qty + Qty to Ship).

e Order Shipment (default);

e Order Creation (available only when 'Decrease Available Qty When Order is Placed' is set to
'Yes');

e Invoice creation;

If you choose to decrease Physical Qty during Order Creation, the Available Qty will be equal to
Physical Qty
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Choose warehouse based on store view only  No b
[global]
If es' is selected then current store view warehouse stock is used
only. All other warehouses and criteria is ignored.

Choose Warehouse based on Criteria Active

[global]

MNearest warehouse

Yes s
Priority of the warehouses Yes -
Store view of the order Yes v
Customer Group assignment Yes -
Stock Yes ¥

Lise the drag & drop option to reorder criteria according which a ﬂ
warehouse(s) for products assigned to multiple storages will be
determined

Return Credit Memo Item to Stock  Yes b
[elobal]
If the option is enabled, the returned items will affect the general
product quantity and will be automatically added to the appropriate
warehouse

Low stock Quantity 1
[global]
Please specify the quantity value for the 'Low Stock'. All products
with the stock level less or equal to the specified value will be
considered as 'Low stock’

Choose warehouse based on store view only - Enable this option to use the stock only of the
current store view warehouse. All other warehouses and criteria will be ignored.

Place the Stock criteria on top and enable it to select warehouse based on available product quantity
and avoid situations when a customer has to receive the order in parts from multiple warehouses.

Choose Warehouse based on - define the warehouse selection algorithm that will be used when
one product is assigned to multiple warehouses. Drag and drop criteria to place them in the order you
need.

NOTE: If all the criteria are set to No, the extension selects the warehouse, that has the biggest
inventory.
NOTE: To get more details on how the algorithm works please see the '‘Order Shipment' section.
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Return Credit Memo Item to Stock - if the option is enabled, returned items will be automatically
added to stock of the appropriate warehouse.

Low Stock Quantity - specify stock quantity that will be considered as a low stock.

Backorders configuration | Product value v

This option defines the value to use for the "Use e
Config Settings” field. By default each product

utilizes the "Use Config Settings" value for

backorders. You can check and modify this options

here: Products > Product Edit > Warehouses >
Backorders Column.

Backorders Algorithm for ordering  Availability first v

roducts ) i
P - The option allows you to define the backorders e

algorithm for ordered products

Backorders configuration — choose Product value or Warehouse value options:

e Product Value — the backorders value will be used from the product's Advanced Inventory;

Please note that by default backorders are not available. Go to product page and unflag the Use
Config Settings box to allow backorders.

e Warehouse value — the global backorders value will be used for each particular warehouse.

This value can be set from the Products in Warehouse section (Products -» Warehouses -
Warehouse). There you can change the backorders settings for each particular product in the
warehouse.

Backorders Algorithm for ordering products — define the primarly rule for using backorders:

* Availability first — choose this option to use backorders instead of selling the products that are
available in other warehouses;

e Backorders first — choose this option to use backorders only when the product is not available
in all warehouses.

Please see the Backorders section of this guide to configure this functionality.

General Settings
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General Settings

Enable Log file | Yes v
[global]
All stock adjustments are logged in var/log
finventory-yy-mm-dd.log

Google Address Suggestion | Enable v
[global]
Enable the Warehouse address auto complete

while typing, using geolocation Google technology

Google APl | AlzaSyA31opvjSWxPOMVsqQPiS0_H-li6%em
[global]
Click here to get an API key. Required for Shipping
from the warehouse closest to customer's area

Enable Log File - Log all stock adjustments.

Google Address Suggestion - Enable this option to automatically fill in address fields while creating
a warehouse.

Google API - This option will automatically determine the warehouse closest to customer's location.

Please click here to get the Google API Key.

Manage Warehouses

To create or edit already created warehouses go to Products - Inventory - Warehouses.
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Manage Warehouses

e

%

o Q

PRODUCTS

Actions - 4 records found

Manage Total Total Available .
Count| Priori
Stock Sku Qty Qty i Y
1 Total Stock ~ Yes 1891 189163 189163 0 0
2 UK Yes 1 624 624 0 57694750374 London GB 1
Warehouse
3 Usa Yes 19 1441 1441 0 7384548354 Los us 2
Warehouse Angeles
4 Australian Yes 0 0 0 0 348907554787  Canberra Al 3
Warehouse

Warehouses Grid - All created warehouses are displayed on a special grid where admin users can
see the necessary warehouse information including stock and address data, store views and customer
groups.

Total Quantity - shows the total number of products stored in a particular warehouse at the current
moment (Available quantity + Quantity to Ship).

Available Quantity - shows the number of products in a warehouse available for orders (Total
Quantity-Quantity to Ship).

Quantity to Ship - show the number of ordered items ready to be shipped.

The module lets you duplicate, edit and delete already created warehouses. To create a new
warehouse please click on the 'Add Warehouse' button.

Warehouse Creation: Warehouse Info

Specify warehouse information including address data and additional description. Use Google
Address Auto Suggestion option when filling in address fields.
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General
Warehouse Name * | USAWarehouse ‘

Warehouse Code *

Address

City

Country

State

Zip/Postal code

Phone

Email Address

Description

USA

WH code is for internal use - e.g. Primary, Po5s (Point of Sale), Supplier,
Offline Shop, Virtual, Defected returns, etc

6574 |

§ 6574 Colins Avenue, Miami Beach, FL, United States

§ 6574 Glenwood Avenue, Raleigh, NC, United States

§ Santa Fe 6574, Rosario, Santa Fe Province, Argentina

§ 6574 Bank Street, ON, Canada

§ 6574 North State Road 7, Coconut Creek, FL, United States

powered by Google
I

]

890805

7384548354

@email: usa.admin@example.com

Show / Hide Editor

i @ B I 1 A‘EG|§ =E=E= | Styles ~ Paragraph = FontFamily = Fo
H | IEmEE Il 2 | — 2| % x| 2 H =1
14 |4 K

Path: p
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Warehouse Creation: Settings
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Settings
Manage Stock (:. Yes

A

If Mo, then Warehouse will be ignored during order assignment

Store View * | All Store Views
Main Website

Main Website Store

English Store View

German Store View

USA Website Store

Main Store View

Alaska Store View

Assign the warehouse to the store view(s). All store views are selected by default

Customer Groups NOT LOGGED IN

General

Wholesale

Retailer

Assign the warehouse to the customer group(s). All customer groups are selected
by default

Warehouse Priority ‘ 2

It is used to assign order item to warehouse automatically based on the Priority
{1is the highest)

Order Email Motification )
usa.admin@example.com ¥ Add more people...

Enter email recipients comma separated

Low Stock Notification
‘ usa.admin@example.com ¥ Add more people...

Store View - Assign the warehouse to a specific store view if necessary.
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One and the same warehouse can be assigned to multiple stores and views.
Customer Groups - Associate the warehouse with a specific customer group(s)

Warehouse Priority - Set the warehouse priority. The option will be used to assign a product to a
warehouse depending on its priority (1 is the highest priority).

Order Email Notifications and Low Stock Email Notifications - specify email addresses to which
notifications will be sent.

Assign Products to a Warehouse

You can either assign all necessary products to a warehouse on the corresponding warehouse page or
add a specific product to multiple warehouses from a product page.

Reset Filter 19 records found Total Qty: 1441 Qty To Ship: 0 Available Qty: 1441

20 v | per page

ID T | Name SKU Price Total Qty ?gpm z\::llable Room & Shelf
Yes |¥ F F From T
i"‘i Ta Ta To
PRODUCTS
7 2044 Erika Running WSH12-32-Red $45.00 57 0 57 13456
Short-32-Red
57
2043 Erika Running WS5H12-32- £45.00 68 1] 68 134.57
Short- Purple
32-Purple
& 2042 Eﬂka Running = WSH12-32-Green £45.00 56 0 56 134.57
ort- s6
32-Green
i 2041 Erika Running = WSH12-31-Red £45.00 111 0 1 134.57
Short-31-Red
111
v 2040 Ealka Running EJ'SH:Z-BL £45.00 34 0 34 134.57
ort- urple 34
31-Purple
w7 2039 Erika Running =~ WSH12-31-Green $45.00 2 0 2 134.57
Short- 2
31-Green

All out of stock products are automatically removed from the product listing.

Assign products on the warehouse settings page - tick items that should be added to the
warehouse and edit their stock quantity (total quantity and quantity to ship) right on the grid. Specify
a room and a shelf info for each item if necessary.

To assign items from a product page to multiple warehouses, please go to Products - Catalog -
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open the product you need and click on the 'Warehouses' link.

Fusion Backpack

Store View:  All Store Views - 0

Enable Product @ ) Yes

[website]

W

PRODUCTS

Attribute Set Bag

Product Name * | Fusion Backpack

[store view]

SKU * | 24-MBO2

[global]

Price * | $ 59.00

website]

Advanced Pricing

Tax Class Taxable Goods v

[website]

Quantity )C (7]

Advanced Inventory

Warehouses

Stock Status In Stock v

[Elobal]

On this page you can assign the product to necessary warehouses, edit their stock and specify a room
& a shelf.
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Warehouses X

4 records found 20 ¥ | per page < 1 |of1 >

Manage . Qty
Available
Product Q:;I . To Total Qty Room & Shelf
Stock Ship
Total Stock 100 0 100
(default) 100
UK o 37 0 0 125-6
Warehouse 37
(UK)
USA 0 0 0
Warehouse ]
{LISA)
Australian 63 1] 0 417-23
w
Warehouse 63
(Australia)

Shipping Methods and Rates
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Shipping methods and rates

Use custom shipping rates ( Yes

Shippings DHL 7.4
Federal Express 9.6
Flat Rate 8
Best Way
Free Shipping 0
United Parcel Service 11

United States Postal Service

Use custom shipping rates - To set your custom shipping methods and rates (different from the
ones set by shipping providers), enable the option.

Shippings - Set your custom rates for each shipping method.

e To set free shipping - enter zero.
e [eave empty to use the shipping providers rates.

Manage Stock
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Manage Stock

W Filters 4> DefaultView -

20 = |per page

Actions - 2046 racords found

Total Stock
Available Qty To

Qty | Ship
2045 Setof Sprite Yoga Straps 24-WG0D85_Group - Enabled 0 0 0
2045 Erika Running Short WSH12 Enabled 0 0 0
2044 Erika Running Short-32-Red WSH12-32-Red Enabled 307 307 o
2043 Erika Running Short-32-Purple WSH12-32-Purple  Enabled 68 68 0
2042 Erika Running Short-32-Green WSH12-32-Green « Enabled 56 56 o
2041 Erika Running Short-31-Red WSH12-31-Red Enabled 112 112 0
2040 Erika Running Short-31-Purple  © WSH12-31-Purple - Enabled 34 34 0
2039 Erika Running Short-31-Green WSH12-31-Green  Enabled 57 57 0

To edit stock data please go to Products - Inventory - Manage Stock.

Total Stock

Status Qty

Available

L Columns = -

Shelf

L demouser ~

To Shelf Qty

Qty

Ship

2046  Set of Sprite Enabled 0 0 0

Yoga Straps

24-WG0B5_Group

Erika
Running
Short

2045 WSH12 Enabled 0 0 0

Erika
Running
Short-32-Red

2044 WSH12-32-Red Enabled 307 0

307
Running

Short- '
32-Purple

2043 WSH1

Erika
Running
Short-
32-Green

2042 W5H12-32-Green Enabled 56 56 0

Erika
Running
Short-31-Red

2041 WSH12-31-Red Enabled 112 112 ©

21

Export «
1 of 103 b
UK Warehouse
Qty ﬁveg!;ble Qst'y:i;n Shelf

0 0 0
0 0 0
250 0 250 0
0 0 0
0 0 0
1 1 0
o] 0 0
55 55 o]

UK Warehouse

Available Qty
To | Shelf
QY | ship
0 0
0 0
21 0
0 0
0 0
1 0
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Manage Stock Grid - To edit stock quantity please select the necessary warehouse on the grid and
click on the box with the value you want to change.

dmin
Manage Stock Q& edmin
W Filters © Defaultview - £ columns v | & Export a
Actions | = 2046 records found (1 20 ¥ |perpage o Csv
selected)
Excel XML

o

PRODUCTS

Total Stock Total Stock
Qty

LVETELIE
aty To Sh UK Warehouse
Ship

W
2046 = SetofSprite = 24WG085_Group Enabled 0 0 0 Ush Warehouse

Yoga Straps .
& P +| Australian Warehouse
2045 | Erika WSH12 Enabled 0 0 o
Running
Short

Cancel Export
v 2044 . Erika WSH12-32-Red Enabled | 307 @ 307 ' O

Running
Short-32-Red

2043 Erika WSH12-32-Purple Enabled B8 68 0 0 o 0 124 B8
Running

Export Stock data - You can export stock data right from the grid. It's possible to export data from
all warehouses at once or choose specific warehouses.

Backorders

Backorders functionality allows you to sell products that are currently out-of-stock in your warehouses
and provides customers with the ability to continue placing orders when the product is unavailable.
With the extension, you can configure various backorders scenarios according to your needs. This
section will guide you through the process of backorders configuration.
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Manage Warehouses QA v -
O-. W Filars AP Defoulk View £ Columns =
ALTigng - 4 nefonds faurd n v | per page 1 of 1

Al lable

Oey

1 Teal Sleele s @ EeI e 2 0 Al All
Store  Customer
Views  Groups

F 19 Yes 1 574 574 a L i aTip e oM STEMTE0ITS Londom GB 1 Al HOT Seled &
Warehouse Store  LOGGED
Views 1N Eak
Giniral
Retaier Duplicaze
- . . Dadete
3 USA Yes 1% 1841 1441 ] s adminSeaamphe cam TIRL5ABI54 Los us ] Al Whilisake
Warehouse Anpeies Stone
Wiews
4 Aarstralian Yies a o o a australa.sdmin@eaampleosm  JARIOPSLATET  Canberra AL a Al All Saleo -
Warehouse Store  Customer

Wiews Groaps

First, you need to configure the global backorders policy for each particular warehouse. Navigate to
Products -» Warehouses and choose one of the available warehouses to edit.

settings

Products in Warehouse

Reset Fllter 11 records found  Total Gty 574 Gty To Ship: 0 Available Gty: 574 20 T | per page i of 1

(8 Erika WEH1Z.  HE00 [ 50

Sunning 12.Red 250 350 In Stock - Use Config Settings -
Short-32:Red
1 Eria WIHIZ  BS00 o 1 R §
Sunning 1-Red 1 I St - Use Cenfig Sentings
Short-31-Red
ik il WEH1Z- 500 o )
55 &5 5 { -
Bunning 3. 5555 I Stock - Use Lonfig Settings -
Short-31 Gresn
Grien

Expand the Products in Warehouse tab. By default options in the backorders column are switched
to Use Config Settings. It means that the global backorder behavior is set using the Backorders
configuration option.

To enable the backorders functionality for selected products in certain warehouses, please modify the
Backorders column for a certain product (disallow backorders or allow gty below 0).
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Backorders configuration | Product value v

globa

' | This option defines the value to use for the "Use (7]
Config Settings" field. By default each product
utilizes the "Use Config Settings" value for
backorders. You can check and modify this options
here: Products > Product Edit > Warehouses >
Backorders Column.

Backorders Algorithm for ordering | Availability first v
products

(global]

The option allows you to define the backorders (7]
algorithm for ordered products

To configure it, go to Stores - Configuration » Amasty Extensions —» Multi Warehouse
Inventory - Stock Settings and modify the Backorders configuration option:

» choose Product value to configure backorders for each particular product and apply this rule
to all warehouses;

e choose Warehouse value to configure backorders for all products in a single warehouse
separately from other warehouses.

Product value

Enable Product ( Yes

[website]

Attribute Set Bag -

Product Name * | Crown Summit Backpack

[store view]

SKU * | 24-MBO3

[global]

Price = | 5 38.00

[website]

Advanced Pricing

Tax Class Taxable Goods | =

[website]

Quantity e

[global]

Advanced Inventory

Warehouses
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If you selected the Product value option, go to Products - Catalog and select the product you
want to add the backorders functionality to. Find the Advanced Inventory link and click it. Then,
unflag the Use Config Settings box under the Backorders option.

Qty Uses Decimals No v
[global]
Allow Multiple Boxes for Shipping No v

Backorders Allow Qty Below 0 v

Use Config Settings

¥| Use Config Settings

Now, you can modify the option and choose Allow Qty Below 0 or Allow Qty Below 0 and Notify
Customer.

This way you can add backorders for required products and this functionality will be added for all
warehouses.

Warehouse value

If you selected the Warehouse value option, go to Products - Warehouses and select one of the
warehouses you want to add the backorders functionality to. Expand the Settings section and modify
the Backorders option by choosing Allow Qty Below 0 or Allow Qty Below 0 and Notify
Customer.
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‘Warehouse Priority 1 e

It is used 1o assign order item W warehowse sutomatically based on the Priority {1 is the highest)

Backorders Mo Backorders -

Order Email Notification _
uk.admin@example.com 3 Add more people...

Enter email recipients comma separated

Low Stock Notification )
uk.admin@example.com 3 Add more people...

Enter email recipients comma separated

Now, the backorders functionality is available for all products assigned to this warehouse. Modify the
same settings for other warehouses if needed.

Backorders configuration examples

1. Enable backorders for all products in particular warehouses

¢ Go to Products » Warehouses, select the required warehouse, and expand the Products in
Warehouse section. Please make sure that the all products in the Backorder column have the
Use Config Settings option selected.

| UK Warehguse] € Back Duplicane Dalete
Products in Warchouse
Lo
Learch Hpspet Fltpr 11 recerds found  Totsld Qfy; 574 Qfty To Ship: 0 Availlable Qay: 504 2 - = g-1T 1 el

Yed
o frica wEHIZ-  gakid Lo ] 243 - . A .
- Pk ' R 250 2% In Steck \se Cordig Settings
Short-13-A
o1 Erica WEHIZ-  SAR00 ] '
' 5 = ol et -
i Rurning 11-Red In Shock Use Conflg Settings
Shart-17-Red
M| rica WEH! TLY N 55 N
- @ : o i 55 55 “ In Steck - Use Conflg Settings -
unning .}
Shart-11 Green
Grewn
37 i WEH 54 &
- Futl :.-i.-g + 2 500 T o § In Sbock " Use Conflg Settings -
Short-30- Purple
Purpie
Fuk ri WEHYZ Al L
y W :.J- . i 500 ag o In Steck . Use Condly Settings -
Shart-30 Green
Green
o

Go to Stores - Configuration - Amasty Extensions » Multi Warehouse Inventory -
Stock Settings and switch the Backorders configuration option to Warehouse value.

f\.__mast'yr


https://amasty.com

Last update:

: i i : 2id= : i i
2017/11/15 11:01 magento_2:multi_warehouse_inventory https://amasty.com/docs/doku.php?id=magento_2:multi_warehouse_inventory

Backorders configuration Warehouse value v

This option defines the value to use for the "Use Config Settings” field. By ﬂ
default each product utilizes the "Use Config Settings™ value for backorders.

You can check and modify this options here: Products > Product Edit >
Woarehouses > Backorders Column,

e Return to the required warehouse in the Products -» Warehouses menu and expand the
Settings section. Switch the Backorders option to Allow Qty Below 0 or Allow Qty Below 0
and Notify Customer.

UK Warehouse

Retailer

Assign the warehouse to the customer groupis). All customer groups are selected by default

Warehouse Pr'r,urit:,' 1 'ﬂ

It is used to assign crder item to warehouse automatically based an the Priarity {1 Is the highest)

Backorders Allow Gty Below O -

Order Email Motification )
uk.adminSexample.com M Add more people

E

wer email recipients comma separated

Low Stock Matification _ _
uk.admin@examplbe.com M  Add more people..

Emt

Br email reCipiers commma Separabed
e You've enabled backorders for all products in this warehouse.

2. Enable backorders for particular products in all warehouses

¢ Go to Products -» Warehouses, select the required warehouse, and expand the Products in
Warehouse section. Please make sure that the all products in the Backorder column have the
Use Config Settings option selected.
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UK Warehouse

Products in Warehouse

& Back Duplicane Delete

petr page 1 el

P Erica WEHIZ-
= Rusning 13-Aed
Shart-11-Ard
- 204 Erica WEHIZ-
Rurning 11-Red
Short-11-Aed
- mm Erica WEHIZ
Rurning 1
Shoet-31 Coven
Grenn
- I Ericy WEHIZ.
Aumning =
Shart- 30 Purple
Purpie
ik Ericy WEHIZ
L Rumning L =3
Shart- 3 Green
Green

AN e 280
4500

BT opes
EET T
P

° 3 In Shoxlke
0 In Stock
o 55 In Steck
o & In Shock
o e In Stock

Lise Cordip Sattings -
Use Condlg Settings -
Use Conflg Settings -
Use Conflg Settings =
Use Config Settings -

Go to Stores - Configuration - Amasty Extensions -» Multi Warehouse Inventory -

Stock Settings and switch the Backorders configuration option to Product value.

Backorders configuration

(global]

Product value

-

This option defines the value to use for the “Use Config Settings” field. By ﬂ
default each product utilizes the "Use Config Settings” value for backorders.
You can check and modify this options here: Products > Product Edit >

Warehouses > Backorders Columin.

* Go to Products - Catalog and select the required product. Click the Advanced Inventory link
and then unflag the Use Config Settings box under the Backorders option.
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Crown Summit Backpack

SKU += | 24-MBO3

[global)

Price + 3 38.00

[website]
Advanced Pricing
Tax Class Taxable Goods = =
[website]

Quantity 100 0

[kabal)

Advanced Inventory

Warehouses

Stock Status n Stock . .0

[global)

e Switch the Backorders option to Allow Qty Below 0 or Allow Qty Below 0 and Notify
Customer. Repeat this operation for all products you want to enable backorders for.

Minimum Qty Allowed in Shopping Cart
[global)

+| Use Config Settings

Maximum Qty Allowed in Shopping Cart

[glabal)
¥ Use Config Settings

Qty Uses Decimals Mo v
[global)

Allow Multiple Boxes for Shipping No v
[global]

Backorders Allow Qty Below 0 -

[global)

D Use Config Settings

Use Deferred Stock Update

[global)

¥ Use Config Settings

* You've enabled backorders for required products in all warehouses.
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3. Set custom backorders behavior for certain products in selected warehouses

This example will help you to provide selected products in certain warehouses with individual
backorders settings.

¢ Go to Products -» Warehouses, select the required warehouse, and expand the Products in
Warehouse section. For the required products modify the option in the Backorder column
from Use Config Settings that is selected by default to the one you need.

| LJK Warehuuse l  Back Dusplicante Dalete

Products in Warehouse

Search Resit Filter 11 recoeds found  Toted Qty; 578 Qty To Ship: 0 Available Qy; 574 ko] T per page 1 el

- e LI‘_" - ":n:r."' MR epa%0 " e In Stock - Use Corfig Settings -
Shart-43-Awd

- o :lf;,. l‘:n:llr: WE ’ . In Stock - Use Config Settings -
Shout-11-Aed

- e :.I-g ot ! In Stock * | |Use Condg Settings =
Short-11 Green
Creen

- L :-:.I-‘:. ‘;._EH.;' il T 67 4 = In Stock - Lise Conflg Settings -
Shart-30 Purpie
Purpin

- s :' ': - ':'.EH.: L 1 o “ In Stock - Use Config Settings -
Shaprt-30 Gresn
e

e You can disable backorders (No backorders) or enable them (Allow Qty Below 0, Allow Qty

Below 0 and Notify Customer. Set the option back to Use Config Settings if you need the
product to utilize global backorders settings.
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UK Warehouse + Badk Duplicate Delete

Products In Warehouse

Search Rzt Filer 11 recornds fond - Total Qty: 574 Oty To Shige 0 Aeallable Oy 574 20 v | per page 1 of 1

ey ow
a4 Erika WSHIE. 4500 o s
o Runing 32 med 280 250 i Sinck v Lt Config Settings *
Sham32-Red
41 Erika WEHIE- 4500 ] 1 § v & Bk =
L Ruring ¥ el L ™ Slock o Bagianders
Shan-Fl-Red
200 I W1 - S 20 a ]
i e ng n- 55 3 n Slock - Alicwy ity Bebow )
Shert-1- Lreer
Curpny
Ford Eriky WEHIZ FA300 o &7
= Runining n ° ! BT &7 i Stock v Aliowy Oty Below 0 and Mooy Dustomar | =
Shear- M- Purple
Purple
203 Erils WEH1 T $L5.00 o o e
- Runring e oo Stock - Mo Backorders -
Shar: 3} Green
Green
wna (™ WEHIZ 4500 . o 151 .
- Running T ed 151 15 i Slock . Aliow ty Bl 0 .
S 28-Red
[ ]

Repeat this operation for all required products in each warehouse.

Export History

To open the Export History grid please go to Products — Inventory —» Export History.
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Manage Q& amin -
Search by keyword Q @ Defaultview v | £ Columns v
Y Filters
Act...| = 3 records found 20 ¥ | per page
1 of 1
Bl m | Fie Created Action
2 uk_warehouse.csv Feb 21, 2017 11:27:03 AM Select =
3 total_stock.csv Feb 21, 2017 11:27:32 AM Select =
4 usa_warehouse.csv Feb 21, 2017 11:30:24 AM Celect &
Download
Delete

Export History Grid - On the grid, you will see all stock data export attempts. It's possible to
download export data to a CSV file or delete them.

Below you'll see the example of an exported CSV file.

sku,code,qty
24-MB04,default,13.0000
24-MBO4, UK, 2.0000
24-MBO4,USA,5.0000
24-MB04, Australia, 65.0000

Import Stock

To import files with stock data go to Products - Inventory - Import Stock.

Import Stock - specify product identifier (SKU or ID) and import stock data using a CSV or XML file.
To import stock data you need to follow the next steps:

1) First of all, browse and upload a file in CSV or XML format
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2) Press “Import”, and then a “To grid” button will appear on the screen. Click on it to continue.

3 2

Import Settings

Product Identifier = | SKU -

Choose SKU or ID to identify the product

File Type * | CSV |

Field separator * | ,

Export & Save the current stock file before import? Yes v

It can be used in order to revert back the changes.

File to Import
1

Select File to Import * Browse File

export_2017_06_20_10_42_49.csv (29 bytes)

3) After you make some changes on the grid, choose the items you need and on the tab “Actions”
select one variant.
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Manage Stocks Q M & «mn-
cariealy e v Q Y Filters € Defaultview +  LF Columns
Actions [ « 11 records found (1 selected) 20 v | per page 1 of 1

Complete Import

Warehouse

Back up & Complete Import
e 24-MB03-1 WH1 20,0000 20.0000

For stock data import you can use the same format as shown in the previous block example.
You can also change the file in the following way:

e in the 1st column you can use either SKU or ID (sku/id);
¢ in the quantity column you can insert + or -;
¢ in the code column please specify the code of your warehouse (except for the default one).

Each product has one field for specifying a shelf location, but you can insert here several values
separated by a comma or by space.

id,code, gty
95,default,13.0000
95, UK, 2.0000
95,U54,5.0000

95, Australia, 6.0000

In our example, we've used product ID instead of SKU.

Low Stock Report

To view and export a low-stock report go to Reports - Warehouse Low Stock.
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Low Stock Q& admin~
Select Warehouse: | Total Stock ) Refresh
UK Warehouse
USA Warehouse
Australian Warehouse =
Export to: Csv v Export

Product Stock Quantity

Joust Duffle Bag 24-MBO1 0

Low Stock Report Grid - Filter report data by a warehouse or view details for all warehouses at a
time. Export report data to a CSV or XML file.

Order Shipment

When an order contains the item assigned to multiple warehouses, the most appropriate warehouse
will be selected according to the criteria you specified in general stock settings in the 'Choose
warehouse based on' setting.
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New Shipment

Items to Ship
Qty to Room &

Product Qty Ship Ship from Warehouse Shelf
Erika Running Ordered 1 1 UK Warehouse | a
Short ' ;

UK Warehouse
SKU:
WSH1 2-32-REC| US\AwarEhDUSE
Color: Red
Size: 32

Ship from Warehouses - the most appropriate warehouse will be selected automatically according
to the above-mentioned settings, but you can select a warehouse manually when creating a
shipment.

Warehouse Selection Logic

e When the order is placed, the extension uses the Available Qty of the product in the Total Stock
(default). The extension assigns a warehouse to every order item. You can change the
warehouses associated to order items during the order shipment.

e |f the item is available in several warehouses, the module selects the warehouse according to
specified parameters (nearest warehouse, store view of the order, warehouse priority, customer

group):
1. The extension starts filtering warehouses by the first criteria.

2. If more than one warehouse is determined, the second parameter is used. And so on until the
warehouse is determined.

3. If after filtering by all specified criteria there are still 2 or more warehouses, the module will select
the one with the highest stock level.

4. In case the most appropriate warehouse doesn’t contain the necessary amount of ordered items,
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the missing amount will be taken from another warehouse.

Update and retrieve stock data via Magento SOAP APl and
REST API

To send or retrieve data via REST APl or SOAP you need to get the Oath token.

To get the key, execute the following command in the ssh console:

curl -X POST "http://magentohost/index.php/rest/V1/integration/admin/token"
H "Content-Type:application/json" -d '{"username":"user",
"password":"password"}"'

! Instead of ‘magentohost’ specify your URL, instead of ‘user’ indicate your admin login and use an
admin password instead of ‘password’.

After that you'll get the key (e.g. $key).

REST API

Service: amastyMultilnventoryWarehouseltemRepositoryV1
/V1/amastymultisetstock: - Send data in the json format to add them to stock.

/V1/amastymultigetstocks/{id}/ - Get information about stocks where the product is stored. For
{id} specify the corresponding product id.

/V1/amastymultigetproducts/{code}/ - Retrieve the list of products (+ products quantity) which
are stored in the warehouse.

1. Send data via SSH

1.1 With the URL

curl -X POST --header "Content-Type: application/json" header "Accept:
application/json" header "Authorization: Bearer $key" -d "{
\"warehouseItem\": {
\"product id\": 11,
\"qty\": 10,
\"room shelf\": \"BB\",
\"warehouse id\": 5
}
1" "http://magentohost/rest/default/V1l/amastymultisetstock"

!Insert your own URL instead of ‘magentohost’ and use the Oath token you've got instead of our
example key ($key).
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curl -X GET --header "Accept: application/json" header "Authorization:
Bearer $key" "http://magentohost/rest/default/V1l/amastymultigetstocks/12/"

! '12'- This is an example product id. Here you should indicate the id of the product you need.

In response we'll get the following data:

“product id": 12

"qty": 10
"available qty": 9
“ship qty": 1
“room shelf": null
"id": 6267

"warehouse id": 1

“product id": 12

"qty": 10
"available qty": 9
"ship qty": 1
“room shelf": "*
"id": 8388

"warehouse id": 3

“product id": 12

"qty": 10
"available qty": 10
"“ship qty": 0

"room shelf": "BB"
"id": 8398

"warehouse id": 5

curl -X GET --header "Accept: application/json" header "Authorization:
Bearer $key"
"http://magentohost/rest/default/V1l/amastymultigetproducts/warehousel/"

! 'warehousel'- This is an example of a warehouse code. Please, specify the code of the warehouse
you need.

In response we get the list of products:
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"gqty": 30
"available qty": 22
"“ship qty": 8

"room shelf": "BB"
"id": 8303

"warehouse id": 3

"product id": 2043

“qty": 18
"available qgty": 18
“ship qty": 0

"room shelf": "AA"
"id": 8304

"warehouse id": 3

“product id": 1

"qty": 10
"available qty": 10
"ship qty": 0

“room shelf": "22"
"id": 8306

"warehouse id": 3

"product id": 13

"qty": 20
"available qty": 20
“ship qty": 0

"room shelf": "AA"
"id": 8314

"warehouse id": 3

2. Send data via PHP

2.1 With the URL

$token $key

$authorization "Authorization: Bearer " $token
$domain "http://magentohost/rest/default/V1l/amastymultisetstock"
$post data
"warehouseItem"
“product id" 11
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Ilqtyll
“room shelf" “BB"
"warehouse id"

$curllnit curl init($domain

curl setopt($curlInit, CURLOPT HTTPHEADER ‘Content-Type:
application/json' "Accept: application/json', $authorization

curl setopt($curlInit, CURLOPT CONNECTTIMEOUT

curl setopt($curlInit, CURLOPT POST, true

curl setopt($curlInit, CURLOPT POSTFIELDS, json encode($post data

curl setopt($curlInit, CURLOPT RETURNTRANSFER, true

$response curl exec($curlInit

curl close($curlInit
$response

! Insert your own URL instead of 'magentohost and use the Oath token you've got instead of our
example key ($key). The data is transferred in array. Place the data in json_encode() and send.

Execute the following command to receive data on GET functions:

$token $key

$authorization "Authorization: Bearer " $token

$domain "http://magentohost/rest/default/V1/amastymultigetstocks/12/"

$curllnit curl init($domain

curl setopt($curlInit, CURLOPT HTTPHEADER, array('Content-Type:
application/json' $authorization

curl setopt($curlInit, CURLOPT CONNECTTIMEOUT

curl setopt($curlInit, CURLOPT CUSTOMREQUEST, "GET"

curl setopt($curlInit, CURLOPT RETURNTRANSFER, true

$response = curl _exec($curllnit

curl close($curlInit
$response

2.2 Zend Framework

It's also possible to send data via Zend Framework used in Magento:

$token $key
$httpHeaders = new \Zend\Http\Headers
$httpHeaders->addHeaders

‘Authorization’ ‘Bearer $token
"Accept’ ‘application/json'
‘Content-Type' "application/json'

Amasty


http://www.php.net/curl_init
http://www.php.net/curl_setopt
http://www.php.net/curl_setopt
http://www.php.net/curl_setopt
http://www.php.net/curl_setopt
http://www.php.net/json_encode
http://www.php.net/curl_setopt
http://www.php.net/curl_exec
http://www.php.net/curl_close
http://www.php.net/curl_init
http://www.php.net/curl_setopt
http://www.php.net/array
http://www.php.net/curl_setopt
http://www.php.net/curl_setopt
http://www.php.net/curl_setopt
http://www.php.net/curl_exec
http://www.php.net/curl_close
https://amasty.com

Last update: . . . ; 2= . . .
2017/11/15 11:01 magento_2:multi_warehouse_inventory https://amasty.com/docs/doku.php?id=magento_2:multi_warehouse_inventory

$request new \Zend\Http\Request
$request->setHeaders ($httpHeaders
$request->setUri('http://magentohost/rest/default/V1l/amastymultisetstock"
$request->setMethod (\Zend\Http\Request: :METHOD POST
$post data
"warehouseItem"
“"product id" 11
"gqty" 10
“room shelf" "BB"
"warehouse id" 5

$params new \Zend\Stdlib\Parameters($post data
$request->setQuery($params

$client new \Zend\Http\Client

$options
‘adapter’ "Zend\Http\Client\Adapter\Curl'
‘curloptions’ CURLOPT_ FOLLOWLOCATION true
'maxredirects’ 0
"timeout’ 30

$client->setOptions($options

$response = $client->send($request
$response->getContent

!Insert your own URL instead of ‘magentohost’ and use the Oath token you've got instead of our
example key ($key).

Execute the following command to receive data on GET functions:

$token $key
$httpHeaders new \Zend\Http\Headers
$httpHeaders->addHeaders

'Authorization' 'Bearer $token
'Accept’ ‘application/json'
'Content-Type' 'application/json'

$request new \Zend\Http\Request

$request->setHeaders ($httpHeaders
$request->setUri('http://mli213.chernov.p70m.sty/rest/default/V1/amastymulti
getstocks/12/"

$request->setMethod(\Zend\Http\Request: :METHOD GET
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$client new \Zend\Http\Client

$options
‘adapter’ 'Zend\Http\Client\Adapter\Curl'
‘curloptions’ CURLOPT FOLLOWLOCATION true
'maxredirects’
‘timeout’

$client->setOptions($options

$response $client->send($request
$response->getContent

SOAP
Service: amastyMultiinventoryWarehouseltemRepositoryV1

amastyMultilnventoryWarehouseltemRepositoryV1addStock - Send data in the json format to
add them to stock.

amastyMultilnventoryWarehouseltemRepositoryV1getStocks - Get information about stocks
where the product is stored. For {id} specify the corresponding product id.

amastyMultilnventoryWarehouseltemRepositoryV1getProducts - Retrieve the list of products
(+quantity) which are stored in the warehouse.

1. Send data via PHP

Send data for stock update

$url
"http://magentohost/index.php/soap/all?wsdl&services=amastyMultiInventoryWar
ehouseItemRepositoryVl'
$params
"http'
"header’ "‘Authorization: Bearer ' $key

$context stream context create($params
$client = new SoapClient($url ‘soap version' SOAP 1 2
‘stream context'=>$context

$post data

'warehouseltem'
"id" null
"productId"
"qty”
"availableQty"
"shipQty"
"roomShelf" "BB"
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"warehouseId" 5

$soapResponse
$client->amastyMultiInventoryWarehouseItemRepositoryVladdStock($post data

json_encode($soapResponse

! Insert your own URL instead of ‘magentohost’ and use the Oath token you've got instead of our
example key ($key).

Receive data via Get

$url
"http://magentohost/index.php/soap/all?wsdl&services=amastyMultiInventoryWar

ehouseItemRepositoryVl'
$params

"http'
"header' "Authorization: Bearer ' $key

$context stream context create($params

$client = new SoapClient($url ‘soap version' SOAP 1 2
‘stream context'=>$context
$soapResponse
$client-=amastyMultiInventoryWarehouseltemRepositoryVlgetStocks
‘id'’ 12

json_encode($soapResponse

Use SKU in API

You can use either product SKU or the product ID & warehouse code or warehouse ID
Find out how to install the Multi Warehouse Inventory extension for Magento 2 via Composer.
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